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1. Introduction 
The Care Coordination (CC) Standardized Episodes of Care (SEOC) is a reference database for 
managing care bundles for use by Veterans Information Systems and Technology Architecture 
(VistA) and other Department of Veterans Affairs (VA) systems. Services are grouped together 
within the SEOC system into bundles so that clinicians can add these bundles to patients consult 
records in a standardized fashion, reducing the amount of time spent manually entering consult 
instructions, and providing uniformity among the patient records and across facilities for how 
patient care is prescribed for similar complaints. 
These bundles group together one or more services that are preselected for different specialties to 
be added to the consult records. In addition, the clinician is provided with information regarding 
prescribing rules and preauthorization requirements, so they can make the most informed 
decisions regarding patient care. 
Additionally, SEOC data will be accessible outside of the VistA/Computerized Patient Record 
System (CPRS) system so that users of downstream applications will be accessing the 
centralized data, and SEOC descriptions, reducing the chances of disconnects. 

1.1. Purpose 
The purpose of this document is to provide instruction for utilizing the SEOC application to 
standardize and streamline consult management for Community Care. 

1.2. Document Orientation 
The Care Coordination (CC) Standardized Episodes of Care (SEOC) v1.10 Administrative User 
Guide will provide explanations of each screen and of all user interface options within the 
context of an easy to understand demonstration data scenario.  
This document is also designed to provide the user with screen-by-screen “how to” information 
on the usage of CC SEOC. 

1.2.1. Organization of the Manual 
Section 1: Introduction 
The Introduction section provides the purpose of this manual, an overview of the SEOC 
software, an overview of the software used, project references, contact information for the user 
to seek additional information, and an acronyms and abbreviations list for this manual. 
Section 2: System Summary 
The System Summary section provides a graphical representation of the equipment, 
communication, and networks used by the system, user access levels, how the software will be 
accessed, and contingencies and alternative modes of operation. 
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Section 3: Getting Started 
Information for the Getting Started section provides a general walk-through of the system from 
initiation through exit, enabling the user to understand the sequence and flow of the system. 
Section 4: Using the Software 
This section gives the user the “how to” information to use SEOC, including many step-by-step 
procedures. 
Section 5: Troubleshooting 
This section provides troubleshooting for the SEOC user. 
Section 6: Acronyms and Abbreviations 
This section provides a list of acronyms and abbreviations found in this document. 

1.2.2. Assumptions 
This guide was written with the following assumed experience/skills of the audience: 

• User has Google Chrome and/or Internet Explorer 11 installed on their machine. 

NOTE: Please note that SEOC is not fully 508 compliant in Microsoft Edge, so the VA 
will continue to support 508 in only Google Chrome and Internet Explorer 11. 

• The SEOC user has basic knowledge of the SEOC system (such as the use of commands, 
menu options, and navigation tools). 

• The SEOC user has been provided the appropriate active roles, menus, and security keys 
required for the SEOC User Interface (UI), as defined below in User Roles.  

• The SEOC user is using SEOC to perform their daily consult creation workflow and 
perform the required SEOC functions. 

• The SEOC user has validated access to the SEOC UI. 
• The SEOC user has been provided training on the SEOC UI and has reviewed the User 

Guide. 
• SEOC Content Authors: The SEOC Content Authors are responsible for creating and 

update the content within the SEOC repository using the SEOC UI. These users are 
required to VA access rights and privileges and will sign on to the SEOC application 
using their SSOI credentials (typically their PIV and access code). 

• CPRS Clinicians that are responsible for documenting patient consult records. These 
clinicians utilize the SEOC content as part of their daily consult creation workflow such 
that they will add a SEOC bundle to the patient consult record which will provide for a 
standardized documentation and care plan approach across the VA for these consults. 

1.2.3. Coordination 
One Consult - Consult Toolbox 1.9.02 and above and the HealthShare Referral Manager 
(HSRM) depend on the availability of the SEOC System. Consult Toolbox 1.9.02 requires active 
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SEOCs whereas HSRM requires active and discontinued SEOCs. Coordination between the One 
Consult – Consult Toolbox, HSRM, and SEOC team is necessary with any updates to SEOC.  

1.2.4. Disclaimers 

1.2.4.1. Software Disclaimer 
This software was developed at the Department of Veterans Affairs (VA) by employees of the 
Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the 
United States Code this software is not subject to copyright protection and is in the public 
domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no 
guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We 
would appreciate acknowledgement if the software is used. This software can be redistributed 
and/or modified freely provided that any derivative works bear some notice that they are derived 
from it, and any modified versions bear some notice that they have been modified. 

1.2.4.2. Documentation Disclaimer 
The appearance of external hyperlink references in this manual does not constitute endorsement 
by the Department of Veterans Affairs (VA) of this Web site or the information, products, or 
services contained therein. The VA does not exercise any editorial control over the information 
you may find at these locations. Such links are provided and are consistent with the stated 
purpose of the VA. 

1.2.5. Documentation Conventions 
This manual uses several methods to highlight different aspects of the material. 

Table 1. Documentation Symbols and Descriptions 

Symbol Description 

 

CAUTION: Used to caution the reader to take special notice of critical information. 

NOTE: Notes are used to inform the reader of general information including references 
to additional reading material. 

1.2.6. References and Resources 
Readers who wish to learn more about CPRS and CC SEOC should consult the VA Software 
Document Library. 

1.3. National Service Desk and Organizational Contacts 
For issues related to the CC SEOC that cannot be resolved by this manual or the site 
administrator, please contact the National Service Desk at 855-NSD-HELP (673-4357). 

https://www.va.gov/vdl/
https://www.va.gov/vdl/
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2. System Summary 
There was an immediate need to provide clinicians the ability to quickly and consistently add 
care bundles to a patient’s consult record within VistA. SEOC provides this feature for a higher 
level of uniformity in patient care, easier access to appropriate services, based on initial 
diagnoses, and the ability to better control care costs. SEOC allows clinicians to enhance the 
coordination of care for the Veteran. 
The system contains SEOCs, or care bundles, that clinicians or other designated individuals can 
assign to VA patients. These bundles allow for the consistent use of procedures when certain 
conditions are diagnosed. This consistency allows the VA to effectively manage patient care and 
provides easier traceability. 

2.1. System Configuration 
The SEOC System is designed to be a simple reference database with a supporting SEOC API 
and User Interface (UI) layer. The SEOC system comprises three application tiers as shown 
below. 

Figure 1: Overview of SEOC System 

 
The first tier is the Data Tier. This tier contains SEOC data. SEOC uses Microsoft Structured 
Query Language (SQL) Server is the database. SEOC data consists of reference data, such as 
SEOC name, associated procedures, associated Current Procedural Terminology (CPT) codes, 
procedure durations, etc. Additionally, user role information is maintained within the tables, but 
no passwords or other credentials are stored. No PHI or PII is stored in the database. SEOC data 
is associated with patient data in the VistA consult record. 
The second tier is the Abstraction Tier. This tier acts as the data broker for the SEOC system. It 
is a REST Application Programming Interface (API), built as a microservice hosted on container 
infrastructure (Docker Container). The API itself is built on the Spring MVC framework. The 
API receives web API calls that are forwarded to the database appropriately. Consuming 
applications are able to query the SEOC system through the SEOC REST API but will not be 
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able to perform updated operations. The SEOC UI uses certificates to authenticate with the 
SEOC REST API to allow data modification within the SEOC system by authenticated users. 
Users are authenticated using SSOI. Additionally, a VistA/MUMPS patch is created to insert the 
SEOC associations into File # 123. 
The third and final tier is the Presentation Tier. This tier consists of the SEOC UI, which 
provides a user interface for approved, authenticated users to maintain the SEOC collection. This 
application is a web application built as a microservice hosted on container infrastructure 
(Docker Container). The UI is built using the React.js JavaScript framework for web 
applications.  

2.2. Data Flows 
Figure 2: SEOC Data Flow Diagram 

 

2.3. User Access Levels 
SEOC user profiles comprise of the following “types of users”: 

• SEOC Content Authors: The SEOC Content Authors are responsible for creating and 
update the content within the SEOC repository using the SEOC UI. These users are 
required to VA access rights and privileges and will sign on to the SEOC application 
using their SSOI credentials (typically their PIV and access code). 
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• CPRS Clinicians that are responsible for documenting patient consult records. These 
clinicians utilize the SEOC content as part of their daily consult creation workflow such 
that they will add a SEOC bundle to the patient consult record which will provide for a 
standardized documentation and care plan approach across the VA for these consults. 

• SEOC data is also accessible to other external consumers in the future (in addition to 
CPRS users). The SEOC API is a RESTFul API that other (to be determined) users will 
have access to use. 

2.4. Continuity of Operation 
The SEOC system is maintained by Enterprise Operations (EO). The continuity of operations is 
managed by EO.  

3. Getting Started 
This section provides a general walkthrough of CC SEOC from initiation through exit.  

3.1. Logging On 
CC SEOC is accessed using the VA Single Sign-On Internal (SSOi) log in using the following 
URL: https://seoc.va.gov/ 

Figure 3: VA Single Sign-On for SEOC 

 

NOTE: After 15 minutes of inactivity the system will automatically log you out. After 13 
minutes of inactivity the system will prompt you to extend your session. 

https://seoc.va.gov/
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Figure 4: Session Timeout Warning 

 

NOTE: The current session is refreshed when a Request is Made to the API, a SEOC 
is updated, a Search or Filter is performed, or any fields for a User or Billing 
Code are updated. 

3.2. System Menu 
The Standardized Episodes of Care home page offers several features: Filter by Status, Filter 
by Name, Export, Manage, Edit Disclaimer, View Selected SEOC, and Draft New SEOC. 
The home page also displays the user name at the top right of the page. 

Figure 5: Standardized Episodes of Care Home Page 

 

 

CAUTION: To view the list of SEOCs using a keyboard interface with assistive 
technology, you will need to use the “Tab” key to navigate through the list.. 
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Standardized Episodes of Care table fields: 

• Service Line – A broad category of care for the services and procedures included which 
is intended to be used to group and filter SEOCs for easier accessibility. A standardized 
three-letter abbreviation of the service line is included at the beginning of the SEOC ID. 

• SEOC Name – A unique title that categorizes a SEOC by specialty/subspecialty or area 
of clinical practice. 

• Version – The version number of the SEOC. The version number is formatted A.B.C 
where the first digit will be 1, the second digit is the number of published SEOCs in the 
same Category of Care when a new SEOC is activated, and the third digit is a serialized 
revision number. 

• Effective Date –The date the SEOC status was made from In-Progress to Active. 
• End Date –The date the SEOC status was discontinued. 
• Status –The SEOC statuses are as follows:  

o Active: When a SEOC is Active, it will be available for all end users (e.g. API 
users, scheduling, payment, and auditing purposes).  

o Date Hold: When the SEOC status is Date Hold, it is pending and set for 
activation on a designated future date. This status is only available for SEOC 
Administrative users for editing purposes.  

o Discontinued: When a SEOC is Discontinued, read-only users will not have 
access to the discontinued SEOC in the SEOC Database and or the scheduling 
interface. However, the discontinued version will still be available for payment 
and auditing purposes. Discontinued SEOCs will remain in the SEOC database 
for up to six (6) years in the central repository. 

o In-Progress: The SEOC is available for editing purposes by the Administrators 
and Authors prior to activation. These SEOCs will not be available via SEOC 
Database API.  

3.3. Changing User ID and Password 
If you need to change your user password, you will need to contact your local PIV office. 

3.4. Exit System 
If you are finished working, log out of VA Single Sign-On and close any secure sessions that 
may still be open by clicking the Logout button. 

4. Using the Software 
The CC SEOC provides user functionality for the following items:  

• Manage Users 
o Filtering Users 

 Filter Users by Role 
 Filter Users by User Name or VA Network ID 
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o Delete a Selected User 
o Edit a Selected User 
o Add a New User 

• Exporting Data 
o Export the SEOC Data to a JSON File 
o Export the VA PreCert Webpage to a JSON Fil 

• Manage Billing Codes 
o Search for a Billing Code 
o Deleting Billing Codes 
o Editing Billing Codes 
o Return to SEOC List 
o Exit Maintenance Mode 
o Extend the Current Session 
o Edit the General Disclaimer 
o Deactivate the General Disclaimer 

• Viewing SEOCs 
o View a Selected SEOC 
o Search for a SEOC by Name 

 Sort SEOCs Alphabetically by Name 
o Filter SEOCs by Status 
o Discontinue a SEOC 
o Print a SEOC 
o Invalid Characters 

 Show Invalid Characters 
 Fix Invalid Characters 

o Track Version Changes 
• Draft a New SEOC 

o Edit an In-Progress SEOC 
o Activate an In-Progress SEOC 
o Delete an In-Progress SEOC 

• Pending Revisions 
o Create a Revision 
o Activate a Revision 
o Revert a Date Hold SEOC Back to In-Progress 
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4.1. Manage Users 
The SEOC Admin UI supports the following user roles: 

• Viewer: Read-Only. This user will only see Active or Discontinued SEOCs on the 
Home Page. They are only able to View, Print, or Track Version Changes on selected 
SEOCs. This user will not see Provider Codes on the View SEOC Page, the Track 
Changes Page, and the Print SEOC Page. Also, by default the SEOC List will show 
only Active SEOCs for this user. 

• Analyst: Has all of the privileges of the Viewer but can also view Date Hold SEOCs. 
They can also Export SEOC Data or Export VA PreCert Webpage Data to a JSON 
file. 

• Author: Has all of the privileges of the Viewer but can also view In-Progress or Date 
Hold SEOCs. They can also Draft a New SEOC, Create Pending Revisions, Delete 
SEOCs, or Edit SEOCs. This user will see Provider Codes on the View SEOC Page, 
the Track Changes Page, and the Print SEOC Page. 

• Publisher: Has all of the privileges of the Author but can also Activate or Discontinue 
SEOCs, Export SEOC Data or Export VA PreCert Webpage Data to a JSON file, and 
Edit the General Disclaimer. 

• Administrator: Has all of the privileges of the Publisher, but can also open the User 
Management page, Add New Users, Edit Users, or Delete Users. However, an 
Administrator can’t modify their own privileges. This ensures there will always be at 
least one Administrator. 

To manage users for the SEOC Admin UI, follow the steps listed below: 
1. As an Administrator on the SEOC Admin home page, select Manage Users from the 

Manage Menu. The User Management window displays. 
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Figure 6: User Management 

 

4.1.1. Filtering Users 

4.1.1.1. Filter Users by Role 
To filter the list of users in SEOC by role, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. From the Filter by Role drop-down menu, select All, Viewer, Analyst, Author, 
Publisher, or Administrator to filter the list of users by role. The list refreshes to 
display the role selected. 

Figure 7: Filter Users by Role 

 

4.1.1.2. Filter Users by User Name or VA Network ID 
To filter the list of users in SEOC by user name or VA network ID, follow the steps listed below 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 
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2. From the User Management page, enter the User Name or VA Network ID of the user in 
the Filter by Name (contains) field.  

Figure 8: User Search Field 

 
3. Click the Search button. The Search User Results display. 

Figure 9: Search Users Results 

 

4.1.2. Delete a Selected User 
To delete a user from the User Management list, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. From the list of users, select the user that you would like to delete.  
3. Click Delete Selected User. A message displays confirming that you would like to delete 

the user. 
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Figure 10: Confirm User Deletion 

 
4. Click Confirm Deletion. The User will be deleted from the User List and a confirmation 

message will display. 
Figure 11: User Deleted Confirmation Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

4.1.3. Edit a Selected User 
To edit a user in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. From the list of users, select the user that you would like to edit. 
3. Click Edit Selected User. The Edit User form will display, populated with the selected 

User information. 
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Figure 12: Editable User Fields 

 
4. Edit the User Name, Role, VA Network ID, and Domain fields as needed. 
5. Click Save. The updated user will display in the list of users. 

Figure 13: Updated User displayed in the User List 

 

NOTE: If any of the fields are not populated, or if VA Network ID or Domain have 
characters other than letters and numbers, an error message will display when 
you click Save. 
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NOTE: Both the error message and the confirmation message can be dismissed by 
clicking the X button. 

4.1.4. Add a New User 
To add a new user from the User Management list, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage, and select Manage Users. The User 
Management window displays. 

2. Click Add New User. The Add New User form displays. 
Figure 14: Add New User  

 
3. In the User Name field, which is required, enter the users name. 
4. From the Role menu, which is required, select Viewer, Analyst, Author, Publisher, or 

Administrator. 
5. In the VA Network ID field, which is required, enter the name of the VA network. 
6. In the Domain field, which is required, enter the name of the domain.  
7. Click the Save button. The new User will appear in the User List and a confirmation 

message will display. 
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Figure 15: New User Added to the List 

 

NOTE: If any of the fields are not populated, VA Network ID or Domain have 
characters other than letters and numbers, or if User Name has a backslash 
character, an error message will display when you click Save. 

NOTE: Both the error message and the confirmation message can be dismissed by 
clicking the X button. 

4.2. Exporting Data 
4.2.1. Export the SEOC Data to a JSON File 
To export the SEOC Data, follow the steps listed below: 

Figure 16: Export Menu: Export SEOC Data 

 
1. As an Analyst, Publisher, or Administrator on the SEOC Admin home page, click 

Export SEOC Data. A dialog displays indicating the data is being downloaded. 
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Figure 17: Export SEOC Data Dialog 

 
2. If needed, click Cancel on the dialog to cancel the data download. 

4.2.2. Export the VA PreCert Webpage Data to a JSON File 
For all users who can Export SEOC Data, the SEOC Admin UI also allows them to export the 
data required for the VA PreCert Webpage. 
To export the SEOC PreCert Data, follow the steps listed below: 

Figure 18: Export SEOC Data 

 
1. As an Analyst, Publisher, or Administrator on the SEOC Admin home page, click 

Export PreCert Data. A dialog will appear indicating the data is being downloaded. 
Figure 19: Export SEOC PreCert Data Dialog 

 
2. If needed, click Cancel on the dialog to cancel the data download. 

NOTE: Please refer to Appendix A for additional steps on converting the JSON file into 
an Excel file. 

4.3. Managing Billing Codes 
NOTE: When updating the Billing Codes, SEOC will go into maintenance mode. SEOC 

users will be unable to update the system until the Admin has completed 
managing the billing codes. 

NOTE: Maintenance mode can be turned off by any Admin. 
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NOTE: When you click on Return to SEOC list from Billing Code Management, it will 
automatically turn maintenance mode off. 

Figure 20: Manage Billing Codes in Manage Menu 

 
To manage the billing codes in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. 
The Billing Code Management window displays. 

Figure 21: Billing Code Management  

 

NOTE: This will place the application into Maintenance Mode for all users. While 
Maintenance Mode is active, users will be unable to save SEOC information 
or navigate to the User Management Page. 
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4.3.1. Search for a Billing Code 
To search for a Billing Code, follow the steps listed below. 
1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. The 

Billing Code Management window displays. 
2. From the Billing Code Management page, enter text in the Search by Billing Code field.  

Figure 22: Billing Code Search Field 

 
3. Press Enter or click the Search button. The table will display all rows where the Billing 

Code column starts with the text you entered. 
Figure 23: Search Billing Codes Results 

 

4.3.2. Deleting Billing Codes 
To delete billing codes in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. 
The Billing Code Management page displays. 

2. From the list of billing codes, select the code that you would like to delete. 
3. Click Delete Billing Code. The Confirm Delete Billing Code dialog box will display 

showing all of the SEOCs that will be affected. 
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Figure 24: Confirm Delete Billing Code Message 

 

NOTE: Verify that you want to delete the billing code listed, as the changes will affect 
the SEOCs listed in the Active and In-Progress tables. 

4. Click Confirm. The Billing Code will be deleted from the Billing Codes List. A 
message will display confirming that that the billing code was deleted and the billing 
code will no longer display in the list. 

NOTE: For all affected SEOCs with a status of Active, a Revision will be created with 
the Billing Code deleted. For all affected SEOCs with a status of In-Progress, 
whether a New SEOC or a Revision, the Billing Code will be removed. For all 
affected SEOCs with a status of Date Hold, the SEOC will be reverted back to 
In-Progress and the Billing Code will be removed. Discontinued SEOCs are 
not affected. 

Figure 25: Billing Code Deletion Confirmation Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 
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4.3.3. Editing Billing Codes 
To manage the billing codes in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. 
The Billing Code Management window displays. 

2. From the list of billing codes, select the code that you would like to edit. 
3. Click Edit Billing Code. The Edit Billing Code form displays, populated with the 

selected Billing Code information.. 
Figure 26: Edit Billing Code 

 
4. Update the Billing Code field as needed. The maximum number of characters for this 

field is 25.  
5. From the Type field, select the correct option: CPT, DRG, HCPCS, HIPPS. 
6. Update the Description field as needed. The maximum number of characters for this 

field is 2,000. 
7. From the PreCert Required field, select the correct option: NO or YES. 
8. Click Continue. The Confirm Update to Billing Code dialog box will display showing 

all of the SEOCs that will be affected. 
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Figure 27: Edit Billing Code Confirmation Message 

 

NOTE: Verify that you want to delete the billing code listed, as the changes will affect 
the SEOCs listed in the Active and In-Progress tables. 

9. Click Confirm. The updated Billing Code will be displayed in the Billing Codes List. A 
confirmation message will display stating that the edits were made to the billing code. 

NOTE: For all affected SEOCs with a status of Active, a Revision will be created with 
the Billing Code updated. For all affected SEOCs with a status of In-Progress, 
whether a New SEOC or a Revision, the Billing Code will be updated. For all 
affected SEOCs with a status of Date Hold, the SEOC will be reverted back to 
In-Progress, and the Billing Code will be removed. Discontinued SEOCs are 
not affected. 

NOTE: If the value of the Billing Code column was not changed as part of the update, 
the change will not be reflected in Track Version Changes. 

NOTE: It is possible to update a Billing Code without changing any values. When a 
Billing Code is updated, the previous version is deactivated, and another 
Billing Code with the updates is used instead. If no values are updated when a 
Billing Code is saved, the current Billing Code is deactivated, and another is 
created with the same values. 

NOTE: If any of the fields are not populated, there are any characters in the Billing 
Code field that are not letters, numbers, a hyphen, or a period, or the 
Description field has a backslash character, an error message will appear 
when you click Continue on the Edit Billing Code form. 

NOTE: The error message can be dismissed by clicking the X button. 
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Figure 28: Billing Code Saved Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

4.3.4. Return to SEOC List 
To return to the SEOC Admin home page and exit Maintenance Mode, follow the steps listed 
below. 

1. From the Billing Code Management page click Return to SEOC List. The SEOC 
Admin home page will be displayed, and the application will no longer be in 
Maintenance Mode. 
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Figure 29: Return to SEOC List 

 

4.3.5. Exit Maintenance Mode 
When the application is in Maintenance Mode, all users will see a notification at the top of the 
page. 

Figure 30: SEOC Admin in Maintenance Mode 

 
To exit Maintenance Mode without navigating to the Billing Code Management page, follow 
the steps listed below. 
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1. From the SEOC Admin home page, click Turn Off Maintenance Mode. The SEOC 
Admin home page will update, and the application will no longer be in Maintenance 
Mode. 

Figure 31: SEOC Admin Not in Maintenance Mode 

 

4.4. Editing Disclaimers 
4.4.1. Edit the General Disclaimer 
All SEOCs share a common General Disclaimer. In the View SEOC Page, Print SEOC 
Window, and Edit SEOC: Details page, it is displayed as Disclaimer. Publishers and 
Administrators can access the Edit Disclaimer page which allows the user to update the 
General Disclaimer for all SEOCs. 
Each SEOC also has Additional Information, which can be used to provide SEOC-specific 
information in addition to the General Disclaimer. 

NOTE: When the General Disclaimer is updated, the change is reflected across all 
SEOCs instantly without updating version numbers or creating new revisions. 

NOTE: Additional Information is SEOC-specific and requires modifying SEOCs with 
the usual methods. 

To edit the General Disclaimer, follow the steps below: 
1. From the SEOC Admin home page, click Edit Disclaimer. The Edit Disclaimer page 

will display. 
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Figure 32: Edit Disclaimer Button 

 
Figure 33: Edit Disclaimer Page 

 
2. Make any updates to the General Disclaimer as needed. 

Click Save Disclaimer. If there are any invalid characters, a dialog will display. For additional 
information on invalid characters, refer to the 4.5.6   
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3. Invalid Characters section in this document. 
Figure 34: Fix Invalid Characters in General Disclaimer Dialog 

 
4. To close the dialog and manually fix the invalid characters, click Cancel. 
5. To save the General Disclaimer and automatically fix the invalid characters, click Save. 

The invalid characters will be fixed as follows: 
o \ will be replaced with a space 
o ‘ or ’ will be replaced with ' 
o “ or ” will be replaced with " 
o • or · will be replaced with * 
o – or — will be replaced with - 
o All other characters will be replaced with a space 

Regardless of whether there are invalid characters, a confirmation message will display 
when the General Disclaimer has been saved. 
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Figure 35: Disclaimer Has Been Saved Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

6. Click Return to SEOC List to navigate back to the SEOC Admin UI home page. 

NOTE: For the Edit Disclaimer page, the Return to SEOC List button will not save the 
General Disclaimer. 
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4.4.2. Deactivate Edit the General Disclaimer 
When the description field of the Disclaimer table in the database is set to NULL, the Edit 
Disclaimer page in the SEOC Admin UI will be inaccessible. The Edit Disclaimer button on the 
SEOC Admin UI home page will be disabled, and if the user attempts to navigate directly to the 
Edit Disclaimer page using the browser address bar, they will be redirected back to the SEOC 
Admin UI home page once the request to fetch the disclaimer is complete. This is similar 
functionality to what is used to restrict users from accessing pages they do not have the 
privileges to access. 
To reactivate the Edit Disclaimer page in the SEOC Admin UI, set the description field of the 
Disclaimer table in the database to a value other than null. 

4.5. View SEOCs 
4.5.1. View a Selected SEOC 
To view a SEOC from the SEOC list, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to view. 
2. Click View Selected SEOC. The View SEOC page displays. 

Figure 36: View SEOC 
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4.5.2. Search for a SEOC by Name 
To search for a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, enter the name of the SEOC in the Filter by Name 
(contains) field.  

Figure 37: SEOC Filter Field 

 
2. Click the Search button. The Search SEOC Results displays. 

Figure 38: Search SEOC Results 

 

4.5.2.1. Sort SEOCs Alphabetically by Name 
To sort the list of SEOCs alphabetically by name, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC Name Column Heading. This will 
sort the list of SEOCs in alphabetical order by name. 
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Figure 39: SEOC Name Column Heading 

 
Figure 40: SEOC List Sorted in Alphabetical Order by Name 

 
2. To sort the list of SEOCs in reverse alphabetical order, select the SEOC Name Column 

Heading again. 



CC SEOC v1.10 
Administrative User Guide 32 January 2020 

Figure 41: SEOC List Sorted in Reverse Alphabetical Order by Name 

 

NOTE: To return to the default sort order, either refresh the page or click the logo in 
the upper-right-hand corner of the page. 

4.5.3. Filter SEOCs by Status 
To filter the list of SEOCs by status, follow the steps listed below: 

1. From the SEOC Admin home page, select Filter By Status menu. 
Figure 42: Filter by Status Menu Options 

 
2. From the list of options select to filter by: All, Active, Date Hold, Discontinued, or In-

Progress. The SEOC list refreshes to display the status filtered by. 

4.5.4. Discontinue a SEOC 
To discontinue a selected Active SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to discontinue. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Discontinue SEOC. The discontinue SEOC confirmation dialog box displays. 
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Figure 43: Discontinue SEOC Confirmation 

 
4. Click Confirm Discontinue. The View SEOC page displays with the updated status of 

the SEOC. 
Figure 44: Discontinued Status 

 

4.5.5. Print a SEOC 
To print a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to print. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Print SEOC. The printed SEOC will display in another window. Print or save 

using local browser capabilities. 
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Figure 45: Printed SEOC Window 

 
Figure 46: Printed SEOC (Bottom of the Page) 
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4.5.6. Invalid Characters 
The following business rules for valid characters are enforced in the SEOC Admin UI: 

• For the Description, Procedural Overview, and Additional Information fields in a 
SEOC, and the Description field in a Payable Service, the following characters are 
accepted: 

o Line Feed (ASCII 10) 
o Carriage Return (ASCII 13) 
o The printable ASCII characters (ASCII 32 – 126) except the DELETE character 

(ASCII 127) 
• For the SEOC Name, the above characters are accepted except: 

o & - Ampersand (ASCII 38) 
o / - Slash (ASCII 47) 
o : - Colon (ASCII 58) 
o \ - Backslash (ASCII 92) 
o ^ - Caret (ASCII 94) 
o | - Vertical Bar (ASCII 124) 
o ~ - Tilde (ASCII 126) 

• For a Billing Code value, the following characters are accepted: 
o Letters 
o Numbers 
o - Hyphen (ASCII 45) 
o . - Period (ASCII 46) 

The user will not be able to activate a SEOC unless all of these rules have been followed. In the 
case of the SEOC Name, the user will be unable to navigate past the SEOC Name and Service 
Line page of the Create / Edit SEOC Workflow if the SEOC Name has invalid characters. For 
Billing Codes, the user will be unable to save the Billing Code if the Billing Code value has 
invalid characters. 
The Show Invalid Characters feature allows the user to highlight invalid characters on any 
SEOC, regardless of status. 

4.5.6.1. Show Invalid Characters 
To show invalid characters on a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select a SEOC with invalid characters. 
2. Click View Selected SEOC, the View SEOC page will display. 
3. Click Show Invalid Characters. The Show Invalid Characters page will display. 

Figure 47: Show Invalid Characters Button 
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Figure 48: Show Invalid Characters 

 
Figure 49: Show Invalid Characters (Bottom of the Page) 

 
4. To print the SEOC with invalid characters shown, click Print SEOC. The Print SEOC 

page will display with invalid characters shown. 
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Figure 50: Print SEOC from Show Invalid Characters Page 

 
Figure 51: Print SEOC from Show Invalid Characters (Bottom of the Page) 

 
5. To return to the View SEOC page from the Show Invalid Characters page, click the 

Hide Invalid Characters button. 
Figure 52: Hide Invalid Characters Button 

 



CC SEOC v1.10 
Administrative User Guide 38 January 2020 

NOTE: The Show Invalid Characters button is only available if the SEOC has invalid 
characters. 

4.5.6.2. Fix Invalid Characters 
Invalid characters in a SEOC can either be fixed manually through the Edit SEOC workflow, or 
automatically with the Fix Invalid Characters feature. Invalid characters are fixed as follows: 

• |, ^, ~, \, /, and & in the SEOC Name will be replaced with spaces 
• ‘ or ’ will be replaced with ' 
• “ or ” will be replaced with " 
• • or · will be replaced with * 
• – or – will be replaced with – 
• All other characters will be replaced with a space 

To automatically Fix Invalid Characters, follow the steps listed below: 
1. From the SEOC Admin home page, select a SEOC with invalid characters. 
2. Click View Selected SEOC, the View SEOC page will display. 
3. Click Show Invalid Characters. The Show Invalid Characters page will display. 
4. Click Fix Invalid Characters. The Fix Invalid Characters confirmation dialog will 

display. 
Figure 53: Fix Invalid Characters Button 

 
Figure 54: Fix Invalid Characters Confirmation 

 
5. Click Confirm Fix Characters. A confirmation message will display. 
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Figure 55: Invalid Characters Fixed Message 

 

NOTE: This feature is only available for In-Progress SEOCs. For Active SEOCs with 
invalid characters, create a Pending Revision, then fix the invalid characters. 

NOTE: The confirmation message can be dismissed by clicking the X button. 

4.5.7. Track Version Changes 
To track the version changes of a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select a SEOC with a previous version. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click the Track Version Changes button when it becomes active. The Track Version 

Changes page will display. 
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Figure 56: Track Version Changes Page 

 
Figure 57: Track Version Changes (Middle of the Page) 

 



CC SEOC v1.10 
Administrative User Guide 41 January 2020 

Figure 58: Track Version Changes: Payable Services 

 
4. Click the Previous Version button. The changes for the previous version will be shown. 

If the previous version is the first version of this SEOC, no changes will be displayed. 
5. Click the Next Version button. The changes for the next version will be shown. 
6. Click the Print SEOC button. The Print SEOC page will display with the current 

changes. 
Figure 59: Print SEOC from Track Version Changes Page 
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Figure 60: Print SEOC from Track Version Changes: Additional Information and Provider 
Taxonomy Codes 

 
Figure 61: Print SEOC from Track Version Changes: Payable Services 

 

NOTE: By default, IE11 will not print the red and green background colors. In order to 
print the red and green background colors, check the Print Background Colors 
and Images box in the Page Setup dialog from the Print menu. 
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4.6. Draft a New SEOC 
To draft a new SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Draft New SEOC. The Draft SEOC: Name 
and Service Line window displays. 

Figure 62: Draft SEOC: Name and Service Line 

 

NOTE: Draft New SEOC only applies to the first page in the Create/Edit SEOC 
workflow. When you navigate to any other page, it will save the SEOC, and 
thereafter the workflow will be presented as an edit to an existing SEOC. 

NOTE: To return to the SEOC Admin home page while creating a New SEOC, click 
Return to SEOC List in the bottom left-hand corner of any page in the 
Create/Edit SEOC workflow. It will not save your changes to the New SEOC. 

2. In the SEOC Name field, enter the name for the new SEOC (required field). The 
maximum number of characters for this field is 80. 

3. From the Service Line menu, select a service line (required field). 

NOTE: If either the SEOC Name or Service Line are not populated, an error will 
display when you click Add/Edit SEOC Details. 

NOTE: If the SEOC Name is already being used by another SEOC, an error will 
display when you click Add/Edit SEOC Details. It is not case-sensitive and it 
does not take extra spaces into account. 

NOTE: The error message can be dismissed by clicking the X button. 
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Figure 63: Edit SEOC Menu 

 
4. In the footer, you can use the Edit menu to save the SEOC and navigate to any other 

page in the Create / Edit SEOC Workflow. 
5. You can also click View SEOC to save the SEOC and open the View SEOC page. 

NOTE: The option in the Edit Menu for the current page will be disabled. For 
instance, in the screenshot above, this is the Edit Name / Service Line page, so 
that option is disabled, but in any other page in the workflow, it will be 
available. 

NOTE: For the purposes of this document, the steps will go through all pages of the 
Create/Edit SEOC Workflow in sequential order, though this is not required in 
the application. 

6. Select Edit SEOC Details from the Edit Menu. The Edit SEOC: Details page will 
display. 

Figure 64: Edit SEOC: Details 
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Figure 65: Edit SEOC: Details (Middle of the Page) 

 
Figure 66: Edit SEOC: Details (Bottom of the Page) 

 
7. From the Category of Care drop-down menu, select the Category of Care. 
8. In the Duration (days) field, enter the duration.  

NOTE: If the value of Duration is not a number between 1 and 365, an error will be 
displayed if you click Return to SEOC List or View SEOC, or if you navigate 
using the Edit Menu. 
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NOTE: The error message can be dismissed by clicking the X button. 

9. From the QASP drop-down menu, select the QASP. 
10. From the REV drop-down menu, select Yes or No. 

NOTE: In order to activate a SEOC, the REV flag can only be true if at least one 
Payable Service has a Billing Code that requires Pre-Certification or is set to 
Any Code Accepted or No Code Required. 

11. In the Description field, enter a description for the procedure. 

NOTE: The maximum amount of characters for the Description field is 2000. 

12. In the Procedural Overview field, enter an overview on the procedure. 

NOTE: The maximum amount of characters for the Procedural Overview field is 5000. 

13. In the Additional Information field, enter additional information regarding the 
procedure if desired. 

NOTE: The maximum amount of characters for the Additional Information field is 
2000. 

NOTE: Disclaimer, above the Additional Information field, refers to the General 
Disclaimer which is shared across all SEOCs. To update the General 
Disclaimer, use the Edit Disclaimer functionality found on the front page. 

14. Select Edit SEOC HPTCs from the Edit Menu. The Edit SEOC: SEOC Provider 
Taxonomy Codes page will display. 
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Figure 67: Edit SEOC: Provider Taxonomy Codes 

 
15. Click Add new HPTCs to SEOC. The Edit SEOC: Add Provider Taxonomy Codes 

page will display. 
Figure 68: Edit SEOC: Add Provider Taxonomy Codes 

 

NOTE: The navigation buttons in the footer will be disabled while this page is 
displayed. In order to enable the navigation buttons, click the Done button to 
return to the previous page. 
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16. Enter text in the Filter HPTC table by text field. Press Enter or click the Search button. 
The table displays all rows with the text you entered in any of the four columns: 
Provider Code, Grouping, Classification, or Specialization. 

17. Select a Provider Taxonomy Code (HPTC). 
18. Click Add Highlighted HPTC to SEOC. A confirmation message will display. 

Figure 69: Edit SEOC: Provider Taxonomy Code Added Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

NOTE: If the selected HPTC has already been added to the SEOC, an error dialog will 
display when you click Add highlighted HPTC to SEOC. 

19. Repeat steps 16-18 to add additional HPTCs to the SEOC. 
20. When you are finished adding provider codes, click Done. The Edit SEOC: SEOC 

Provider Taxonomy Codes page will display. The table displays the provider codes you 
added on the previous page. 
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Figure 70: Edit SEOC: Added Provider Taxonomy Codes 

 
21. If needed, you can select an HPTC row and click Remove highlighted HPTC from 

SEOC to remove an HTPC. The Confirm Remove HPTC dialog will display.  
Figure 71: Edit SEOC: Confirm Remove HPTC 

 
22. Click Confirm to remove the HPTC from the SEOC. A confirmation message will 

display. 
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Figure 72: Edit SEOC: Provider Taxonomy Code Removed Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

23. Select Edit SEOC Payable Services from the Edit Menu. The Edit SEOC: Payable 
Services page will display. 

Figure 73: Edit SEOC: Payable Services  

 
24. Click Add New Service to SEOC. The Edit SEOC: Add Payable Service section 

displays at the top of the page. 
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Figure 74: Edit SEOC: Add Payable Service 

 
Figure 75: Edit SEOC: Add Payable Service (Middle of the page) 
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Figure 76: Edit SEOC: Add Payable Service (Bottom of the Page) 

 
25. In the Description field, which is required, enter a description for the payable service. 

NOTE: The maximum number of characters for the Description field is 2000. 

26. Under Clinical Services, which are required, select Add Clinical Service. The Edit 
SEOC: Add Clinical Service dialog box will display. 

Figure 77: Edit SEOC: Add Clinical Service Dialog 
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27. Enter text in the Search for Clinical Service field. Press Enter or click the Search 
button. The table displays all rows with the text you entered. 

28. Select the desired Clinical Service. 
29. Click Add Clinical Service to Payable Service. A confirmation message will display. 

Figure 78: Edit SEOC: Clinical Service Added Message 

 

NOTE: If a Clinical Service is already associated with the Payable Service, an error 
message will display. 

NOTE: Both the confirmation message and the error message can be dismissed by 
clicking the X button. 

30. Repeat steps 27-29 to add additional Clinical Services to the Payable Service. 
31. Click Done. The Edit SEOC: Add Payable Service section will display. 

Figure 79: Edit SEOC: New Clinical Services added to the Payable Service 

 
32. If needed, select a Clinical Service row and click Remove Selected Clinical Service to 

remove a Clinical Service. A confirmation message will display. 
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Figure 80: Edit SEOC: Clinical Service Removed Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

33. In the Allowable Visits / Units field, which is optional, enter the number of allowed 
visits or other units. 

NOTE: The maximum value for the Allowable Visits / Units field is 999. 

34. In the Frequency (visits/interval) fields, which are optional, enter the frequency of visits 
and select if it is per week, month, or year. 

NOTE: The maximum value for the Frequency Visits field is 999. 

NOTE: If either the Frequency Visits or the Frequency Interval field is populated 
without the other, an error will be displayed if you click Done. 

NOTE: The error message can be dismissed by clicking the X button. 

35. If this service does not require billing codes, select No Code Required. A confirmation 
message will display. 

Figure 81: Edit SEOC: No Billing Codes Required Added Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

36. If you need to remove this and select something else, click Remove Selected Code from 
Service. A confirmation message will display. 
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Figure 82: Edit SEOC: No Billing Codes Required Removed Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

37. If this service can accept any billing code, select Accept Any Code. A confirmation 
message will display. 

Figure 83: Edit SEOC: Any Billing Code Accepted Added Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

38. If you need to remove this and select something else, click Remove Selected Code from 
Service. A confirmation message will display. 

Figure 84: Edit SEOC: Any Billing Code Accepted Removed Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

39. If this service requires billing codes, click Add New Billing Code to Service. The Edit 
SEOC: Add Billing Code dialog box will display. 
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Figure 85: Edit SEOC: Add Billing Code  

 
40. Enter text in the Search by billing code field. Press Enter or click the Search button. 

The table will display all rows where the Billing Code column starts with the text you 
entered. 

41. Select the desired Billing Code. 
42. Click Add Code to Payable Service. A confirmation message will display. 

Figure 86: Edit SEOC: Billing Code Added Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

43. Repeat steps 40-42 to add additional Billing Codes to the Payable Service. 
44. To define a new Billing Code, click Define New Code. The Define New Code form will 

display. 
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Figure 87: Edit SEOC: Define New Billing Code 

 

NOTE: If you had entered a billing code in the Search by Billing Code Field before 
clicking Define New Code, the Billing Code Field will be pre-populated with 
the value from the Search by Billing Code Field. 

NOTE: If the pre-populated value for the Billing Code Field starts with a letter, the 
Type menu will default to DRG. Otherwise, it will default to CPT. 

45. In the Billing Code field, which is required, enter the billing code. 

NOTE: The maximum number of characters for the Billing Code field is 25. 

46. From the Type menu, select the type of billing code (required field). 
47. In the Description field, which is required, enter the billing code description. 

NOTE: The maximum number of characters for the Description field is 2000. 

48. From the PreCert Required menu, select whether the billing code requires pre-
certification (required field). 

49. Click Add Code to Payable Service. The new code will be added to the current payable 
service. A confirmation message will display. It will also be available in the list of billing 
codes in the Add Billing Code dialog box. 

NOTE: If any of the fields are not populated, there are any characters in the Billing 
Code field that are not letters, numbers, a hyphen, or a period, or the 
Description field has a backslash character, an error message will appear 
when you click Add Code to Payable Service. 

NOTE: The error message can be dismissed by clicking the X button. 
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Figure 88: Edit SEOC: New Billing Code Added Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

50. Click Done. The Edit SEOC: Add Payable Service section will display. 
Figure 89: Edit SEOC: Billing Codes added to the Payable Service 

 
51. If needed, you can select a Billing Code row and click Remove Selected Code from 

Service to remove a Billing Code. A confirmation message will display. 
Figure 90: Edit SEOC: Billing Code Removed Message 
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NOTE: The confirmation message can be dismissed by clicking the X button. 

52. Click Done. The Edit SEOC: Payable Services section displays at the top of the page. 
Figure 91: Edit SEOC: Payable Service added to SEOC 

 

NOTE: If any of the required fields are not populated, or if Allowable Visits/Units or 
Frequency are not numbers within the specified range, an error message will 
appear when you click Done. 

NOTE: The error message can be dismissed by clicking X. 

53. If needed, you can select a Payable Service row and click Remove Selected Service 
from SEOC to remove a Payable Service. The Confirm Delete Payable Service dialog 
will display. 

Figure 92: Edit SEOC: Delete Payable Service Confirmation 

 
54. Click Confirm Deletion to remove the Payable Service. A confirmation message will 

appear. 
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Figure 93: Edit SEOC: Payable Service Removed Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

55. You can also select a Payable Service row and click Edit Selected Service to edit the 
selected Payable Service. 

56. Click View SEOC. The information you entered will be displayed, including Provider 
Taxonomy Codes (HPTCs) and Payable Services. The In-Progress (New) status will 
display in the window. 
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Figure 94: Edit SEOC: View SEOC 

 
Figure 95: Edit SEOC: View Provider Taxonomy Codes and Payable Services 
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4.6.1. Edit an In-Progress SEOC  

NOTE: If a user attempts to edit a SEOC that another user is already editing, the user 
will receive a message stating that the request can’t be processed. 

NOTE: If a user attempts to edit a SEOC while the system is in maintenance mode for 
Billing Code Management, the user will receive a message stating that the 
request can’t be processed. 

To edit a SEOC that is currently marked as In-Progress, follow the steps listed below: 
1. From the SEOC Admin home page, select the SEOC you would like to edit. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click EDIT SEOC. The Edit SEOC: Name window displays. 
4. Follow the workflow in the previous section to edit any fields as necessary. 
5. Click View SEOC to confirm the edits. 

4.6.2. Activate an In-Progress SEOC 
To activate a SEOC that is currently marked as In-Progress, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to activate. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Activate SEOC.  

NOTE: Once the SEOC is activated, the previous version status is automatically set to 
Discontinued. 

4. If there are activation errors, the Activation Error dialog will display listing what needs 
to be resolved before the SEOC can be activated. 

Figure 96: SEOC Activation Errors 

 
5. If there are no activation errors, the Confirm Activation dialog displays. 
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Figure 97: SEOC Activation Confirmation 

 
6. The Effective Date will default to the next day at 12:01AM EST. If needed, enter a new 

Effective Date in the input or click the calendar icon to select a date. 
Figure 98: SEOC Activation Confirmation Calendar 

 
7. Click Confirm Activation. A confirmation message will display. The Date Hold status 

will display in the upper-right-hand corner of the page. 
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NOTE: The SEOC will remain in Date Hold status until 12:01AM EST on the specified 
Effective Date. At that time, the SEOC will change to Active status. 

Figure 99: SEOC Will be Activated Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

8. Click Return to SEOC List to see the SEOC in the list with a Date Hold status. 

4.6.3. Delete an In-Progress SEOC 
To delete a SEOC that is currently marked as In-Progress, follow the steps listed below: 

1. From the SEOC Admin home page, select the draft SEOC you would like to delete. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Delete SEOC. The Confirm Deletion dialog box displays. 

Figure 100: Confirm Deletion  

 
4. Click Confirm Deletion. The SEOC is deleted from the SEOC List. 
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4.7. Pending Revisions 
4.7.1. Create a Revision 
To create a revision to an existing SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the active SEOC you would like to create a 
pending revision. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Create Pending Revision. The Revision: Name and Service Line window 

displays. 
Figure 101: Revision: Name and Service Line 

 

NOTE: To return to the SEOC Admin home page while editing a new SEOC or 
Revision, click Return to SEOC List in the bottom left-hand corner of any page 
in the Edit SEOC workflow. 

4. Update the SEOC Name and Service Line as needed. 
5. Click Add/Edit SEOC Details. The Revision: Details window displays. 



CC SEOC v1.10 
Administrative User Guide 66 January 2020 

Figure 102: Revision: Details 

 
Figure 103: Revision: Details (Middle of the Page) 
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Figure 104: Revision: Details (Bottom of the Page) 

 
6. Update the details for the SEOC as needed. 
7. Click Add/Remove HPTCs. The Revision: SEOC Provider Taxonomy Codes window 

displays. 
Figure 105: Revision: SEOC Provider Taxonomy Codes 

 
8. Update the Provider Taxonomy Codes (HPTCs) for the SEOC as needed. 
9. Click Add/Edit Payable Services. The Revision: Payable Services window displays. 
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Figure 106: Revision: Payable Services 

 
10. Select a Payable Service. 
11. Click Edit Selected Service. The Edit Payable Service section will display. 

Figure 107: Edit Payable Service 
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Figure 108: Edit Payable Service: Billing Codes 

 
Figure 109: Edit Payable Service: Billing Codes and Action Buttons 
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Figure 110: Edit Payable Service: Payable Services List 

 
12. Make any desired updates 
13. Click Done. The Revision: Payable Services page will display. 
14. Repeat steps 10-13 for the other Payable Services as needed. 
15. Click View SEOC. The In-Progress (Revision) status will display in the window. 

Figure 111: In-Progress (Revision) Status 

 
16. Click Return to SEOC List. The Revision will display in the list of SEOCs. 
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Figure 112: Revision Displayed in SEOC List 

 

4.7.2. Activate a Revision 
To activate a pending revision, follow the steps listed below: 

1. From the SEOC Admin home page, select the Revision SEOC that you would like to 
activate. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Activate SEOC. If there are activation errors, the Activation Error dialog will 

display listing what needs to be resolved before the SEOC can be activated. 
Figure 113: Revision Activation Errors 

 
4. The Revision Activation Confirmation message displays. 
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Figure 114: Revision Activation Confirmation Message 

 
5. The Effective Date will default to the next day at 12:01AM EST. If needed, enter a new 

Effective Date in the input or click the calendar icon to select a date. 
Figure 115: Revision Activation Confirmation Date Calendar 

 
6. Click Confirm Activation. A confirmation message will display. The Date Hold Status 

will display in the upper-right-hand corner of the page. 
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Figure 116: Revision Will be Activated Message 

 
7. Click Return to SEOC List. The pending revision that you just activated will display as 

Date Hold in the list of SEOCs. 

NOTE: The Revision will remain in Date Hold status and the previous SEOC will 
remain in Active status until 12:01 AM EST on the specified Effective Date. At 
that time, the Revision will change to Active status and the previous SEOC will 
change to Discontinued status. 

4.7.3. Revert a Date Hold SEOC Back to In-Progress 
If you need to revert the selected SEOC to In-Progress, follow the steps listed below: 

1. From the SEOC Admin home page, select the Date Hold SEOC you would like to revert 
back to In-Progress. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Revert SEOC to In-Progress. The Confirm Revert SEOC to In-Progress dialog 

will display. 
Figure 117: Confirm Revert SEOC to In-Progress 
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4. Click Confirm. The SEOC will be reverted back to In-Progress and a confirmation 
message will display. 

Figure 118: SEOC Reversed to In-Progress Message 

 

NOTE: The confirmation message can be dismissed by clicking the X button. 

5. Troubleshooting 
Users may encounter the following errors while using the SEOC UI.  

Table 2: SEOC Error Codes with Descriptions 

Error Code Description 

204 No Content Found 

401 Unauthorized 

403 Forbidden 

404 Not Found 

6. Acronyms and Abbreviations 
Acronym Definition 
CAC Clinical Application Coordinators 

CC Care Coordination 

CCAD Community Care Agile Development 

CDW Corporate Data Warehouse 

CID Clinically Indicated Date 
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Acronym Definition 
CPRS Computerized Patient Record System 

HEC Health Eligibility Center 

HPTC Healthcare Provider Taxonomy Code 

JSON JavaScript Object Notification 

NSD National Service Desk 

OIT Office of Information and Technology 

PCP Primary Care Physician 

SAR Secondary Authorization Request 

SEOC Standardized Episode of Care 

VA Department of Veterans Affairs 

VDL VA Software Document Library 

VistA Veterans Health Information Systems and Technology Architecture 
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A. JSON Instructions 
NOTE: The steps outlined below are for Excel 2016. 

To convert the SEOC JSON file to an Excel file, follow the steps listed below: 
1. Select to download the SEOC JSON file. The Internet Explorer File Download Prompt 

displays at the bottom of the window. 
2. From the Save menu, select Save as. The Save As window displays. 
3. Select to download the file to the Desktop and click Save. 
4. Open a blank workbook in Excel 2016. 
5. Click the Data tab, then Get Data > From File > From JSON. The Import Data 

window displays. 
Figure 119: Import Data Window 

 
6. Select the JSON file you downloaded and click Import. Excel will open the file in the 

Query Editor. 
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Figure 120: Query Editor 

 
7. Click the List header to the right of Seocs to display a list of records. 

Figure 121: List of Records 

 
8. From the Transform tab, click the Convert To Table icon and click OK. The To Table 

dialog box displays. 
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Figure 122: To Table Dialog Box 

 
9. From the To Table dialog box keep the default selections and click OK. 
10. Click on the expand icon (<-||->) to the right of the Column1 header to display the 

Search Columns to Expand dialog box. 
Figure 123: Search Columns to Expand Dialog Box 
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11. De-select the Use original column name as prefix check box. 
12. Click OK. 
13. Click on the expand icon (<-||->) to the right of the Seoc header to display the Search 

Columns to Expand dialog box. 
Figure 124: Search Columns to Expand 

 
14. Uncheck the Use original column name as prefix check box. 
15. Click OK. The fields in the SEOC table will be expanded to columns as shown below. 
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Figure 125: Expanded SEOC Fields 

 
16. Scroll right to the services column, click on the expand icon, and select Expand to New 

Rows to display the records. 
Figure 126: Expand to New Rows Menu Option 

 
17. Click the expand icon again and press OK to expand the Payable Services fields into 

columns. 
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Figure 127: Payable Services Columns 

 
18. Scroll right to the billingCodes column and repeat the last two steps to expand the 

Billing Code fields into columns. 
Figure 128: Billing Code Columns 

 
19. Optional - Repeat the last two steps again for the serviceHptcs column if you want to see 

the cross-walked HPTCs that are sent for each Payable Service. 
20. Scroll right and repeat the last two steps again for the hptcs column to expand the HPTC 

fields that were assigned to each SEOC.  
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Figure 129: Expanded HPTC Fields 

 
21. Click the Close & Load option at the left of the ribbon to create load the imported data 

into a spreadsheet tab. 
Figure 130: Imported Data 
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